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Using the Internet

What is the Internet?
Connecting to the World Wide Web, using a browser and developing skills in
searching the Internet enables people access to information all over the world.
The Internet, sometimes referred to as the ‘Information Superhighway’ is an
important communication method for people wherever they are.

What is a browser?
A browser is software used to access the World Wide Web. Browser software is
usually provided free and is included with the operating system.

The browser, when opened, goes to the page nominated in the preferences. In
Internet Explorer, this is found at Internet Options on the View menu.
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Figure 5.1
Internet Explorer
browser software
showing menus,
buttons and
windows
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Navigating the Web with a browser
The browser includes a number of different tools for users.

Key features of the browser screen
The browser ‘View’ menu has access to ‘bars’, these include the:

• button bar
• address bar
• favorites bar
• status bar
• explorer bar.

A browser keeps a record of pages visited during each session. It can also keep
a listing of sites that you find useful.

Forward and back buttons

The Forward and Back buttons allow you to move between the pages that you
have been accessing. Clicking on the Forward button takes you to the next page,
providing you have viewed it previously. Clicking on the Back button takes you to
the previous page that you have visited.

History of pages visited

The History icon on the toolbar stores a list of pages visited. The user sets the
number of days for which addresses are to be stored. The pages visited on
previous days are grouped by that day’s date.

Listing the current session

As each page is opened, the browser keeps a record of the addresses.

Listing favourite sites

Sites that are particularly useful can
be listed in the Favorites menu on
Internet Explorer. These are called
Bookmarks in Netscape
Communicator. 

A site can be added to the
Favorites or bookmarked. Using
Internet Explorer, this is done using
the Add to Favorites … command on
the Favorites menu.

The Favorites may be kept either
as a single entry or grouped in
folders.

Figure 5.2
Favorites menu
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Import and Export of Favourites
Using the Import and Export command on the File menu activates a wizard that
allows favorites to be imported or exported from a file or from another browser.

Your turn
1 How many different sites have you listed on your Favorites menu? Are all of them useful?
2 How do you add a site to your Favorites menu?
3 How do you delete a site from your Favorites menu?
4 How do you group sites into folders on the Favorites menu?
5 Enter the following addresses in the address bar and move to the associated site. What

are the features of each site?
www.yellowpages.com.au
www.microsoft.com.au
www.news.com.au

What is the cache?
A portion of the hard disk space on a computer can be set aside as a cache for the
browser. The cache stores the text and graphics for each page as it is accessed.

The cache is used to store files so pages that are frequently visited can be
loaded quickly. When the browser is sent to an address, it first looks at the cache.
If the files are present in the cache, it will use them rather than download the files
from the actual site.

When the cache is full, it will ‘clean up’ by removing the earliest files
downloaded to make room for information from new pages.

Internet Explorer refers to these as ‘Temporary Internet files’. It allows the user
to set the amount of disk space allocated to storing these files. Choosing Internet
Options on the Tools menu and then selecting the General tab provides the
opportunity to allocate the disk space. Clicking on the Settings button displays the
window for making changes. The option to check for newer versions of the page
is used to ensure files stored on a local hard disk do not become out of date.

Figure 5.3
Adding favourites
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Setting up the browser
Preference settings alter the manner in which a browser behaves and can set the:

• font type and size for use in documents
• way the document is viewed—showing graphics and text or text only
• colour of hypertext links (visited, unvisited and active)
• page displayed when the browser is opened.

Figure 5.4
Setting for changing
Internet options

Figure 5.5
Setting up the
browser options
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Your Turn
1 Which browser do you use to access the Web?
2 What page is opened when the browser is started? How do you change that page?
3 What font is used to display text? How do you change that font?

Using a browser

Understanding the address
A Universal Resource Locator (URL) identifies the address of a page on the Web.

The Australian Government has a home page with the address:
http://www.australia.gov.au
The first part (http://www.) identifies that a site is part of the World Wide Web

and its documents are in accord with the hypertext transfer protocol (http).
Browsers and web servers use http to communicate with each other.

The second part (australia.gov.au) identifies the organisation or body that is
hosting the site, followed by the country domain. In this case the country domain
is ‘au’. Sites in the United States of America do not include a country domain.

Figure 5.6
Australian
Government 
home page 
showing the URL 
in the address bar
www.australia.gov.au



68 First Byte

What types of sites are on the Web?
Web sites are many and varied. Most organisations have developed web sites and
are continually refining their presence on the Web.

Many media organisations have sites that provide information published on
paper. All major Australian newspapers have web sites. The Australian
Broadcasting Corporation has a site, as do other television and radio stations.
These sites are modified during the day and they include updated news stories as
they become available.

Business web sites provide communication with news about products and
services.

Some business web sites enable ordering and purchasing of goods and services.
This is known as electronic commerce or e-commerce.

The organisation extension
The organisation extension, which is part of the web address, gives an idea of the
primary purpose of a site. The extensions include:

.com—commercial businesses

.edu—educational

.net—internet service provider

.org—non-profit and non-government organisations

.gov—governments and government departments

.inf—providing information.

Your turn
1 Find an example of a site that includes each of the above extensions
2 Select two sites with the ‘.edu’ extension.
3 Identify five organisations or businesses that currently use electronic commerce on the

Internet.
4 What advantages do you see in purchasing goods across the Internet?
5 What concerns do you have about purchasing goods across the Internet?

What is a home page?
The home page is the entry page to a site. It is the page that is delivered when the
URL of a site is requested by a browser. It usually contains information about the
site and links to other parts of the site. 

Any page at a site can be accessed via the home page or by its own unique
address.

What is a page?
A page is a file in text format stored on a Web server. The page usually contains
text, hypertext links and graphics. The page also contains HTML text that
instructs the browser how to display the content on the screen. The HTML code
is not shown on screen.
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Composing a page
The browser composes the page from top to bottom and left to right. Text is seen
first and is followed by the images as they are loaded. The web server progressively
delivers content to the browser and the browser delivers that content to the
screen.

The browser can be set to show images or not to show them (for faster
loading). See Figure 5.5 to see the setting of a default homepage in Internet
Options.

Features of a page
Each page has a unique URL. A page can:

• be a single screen or a number of screens in length
• have its own width and height set by the user within the browser
• ‘word wrap’ depending on the screen and window size
• have windows in which the user can scroll up and down.

Figure 5.7
A home page
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Your turn
1 Visit a range of home pages. Click on a button that takes you to a different area. Note 

the address for the new page. Try this with the following home pages:
www.microsoft.com
www.microsoft.com.au
www.cnn.com
www.theage.com.au
www.hotbot.com
www.bbc.com.uk

2 In which countries are each of the above home pages located?

Page content
A web page can include:

• text
• images
• sound
• animation
• video
• hypertext links and hotspots.

Some content also requires a plug-in to be displayed. These applications help
display particular kinds of data in the browser. These are often used to display
multimedia files within the browser.

The HTML code that contains the instructions to make up or compose the
page is not shown on screen by the browser.

Text
Text is usually shown on the screen using the default font that is set in the
browser preferences. When using Internet Explorer, choosing Internet Options on
the View menu and then selecting the General tab provides the opportunity to set
the font. Clicking on the Font button displays the window for making changes.

In some cases, the author of the page specifies the font type, size and colour.
This can override the browser preferences.

Text can be created as a graphic image to preserve the layout of a page for
important areas such as the home page, menu items and navigation areas.

Hypertext and hyperlinks
Blue and underlined text on a web page is the browser default for a hyperlink.
The cursor changes its shape to a hand as it moves over the link. 

When the hyperlink is clicked it points the browser to an address embedded in
HTML.
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Where does a hyperlink point?
A hyperlink can be made to:

• another point on the same page (called an anchor)
• a different page on the same web server
• a page on a computer linked to the same network
• a page anywhere on a computer linked to the Web.

The destination of a hyperlink is not always apparent from the text. However,
the address of the link can be seen in the ‘status bar’ at the bottom of the browser
window.

Figure 5.8
Hyperlinks on the
Age web site



72 First Byte

Visited hyperlink
The text colour of a hyperlink changes after it has been clicked. The default
colour of a hypertext link is blue, and red after it has been clicked. 

These browser default settings allow a user to distinguish the links as visited or
not yet visited.

Clickable image maps
A clickable image map is a graphic that has hotspots embedded in it. A hotspot is
an area inside an image that has a URL embedded in HTML. The URL will be
activated when the image is clicked. Navigation graphics such as the map of
Australia in Figure 5.9 are common examples of clickable image maps.

Your turn
1 Identify the different content types shown on the web page in Figure 5.10. List items as

text, jpeg images, gif images, animated gif images and hyperlinks.
2 The contents of which items are likely to change with the new edition of the online

paper?
3 Are there any items of content that could change in the current edition as it is viewed?
4 If there was a major story of national significance breaking during the day, what could

happen to the page?

Figure 5.9
The Bureau of
Meteorology site
includes a clickable
image map
www.bom.gov.au
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Saving a page for offline viewing
A web page can be saved to disk for:

• archiving
• viewing off-line
• viewing the HTML code used to construct the page.

The file formats and their use are shown in Table 5.1

Table 5.1 Save options for Internet Explorer

File type Extension Features

web page, complete .htm, .html a html page and a new folder automatically created
containing ‘non text’ content as separate files
page can be viewed as original

web archive, single file .mht a .mht file with all content stored as part of the page
page can be viewed as original

web page, HTML only .htm. html source only, allows page to be displayed with text only and 
attributes set by HTML

text file .txt text information only, will open in a text editor, for example,
Notepad, Microsoft Word

Figure 5.10
The Sydney Morning
Herald site 
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Your turn
1 How much cache is set for saving pages on the computer you use? How do you alter the

size of the cache? What impact does the size of the cache have on the speed of loading 
a page?

2 How long are pages stored in the cache on the computer you use? How can this be
changed?

Extending browsers
Browser software enables viewing of text and images. Other media types 
such as audio, video and animation can be integrated into web pages. However,
these media types require extra software called ‘plug-ins’.

These multimedia formats often need another piece of software called a ‘plug-
in’. For example, Macromedia’s Flash is a widely used piece of software for
creating animations. Displaying a Flash animation, requires the installation of the
Flash plug-in in the browser.

Information on the Flash plug-in can be found at www.macromedia.com.

Figure 5.11
The plug-in
download page
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Portable Document Format—PDF
The PDF file format was developed by the Adobe software company. This format
preserves fonts and layout and can be viewed on the screen looking just as a
printed version would appear.

Many different computer types and different operating systems can be used to
view PDF documents.

PDF documents can be viewed:
• within a web browser using a plug-in
• using free reader software from Adobe called Adobe Reader

PDF documents are used by:
• software publishers to distribute information and manuals
• book publishers to sell on-line versions of novels and other books
• organisations to distribute invitations and brochures.

Downloading a PDF file
A PDF file is often just represented as a link on a HTML page. Holding the mouse
on the link will activate the download process.

Once the download has finished the file will be located on the computer hard
disk and it can then be opened by double clicking it. Adobe Acrobat Reader is
freely available for download from Adobe’s website.

Figure 5.12
Downloading
Adobe Reader
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Finding information on the Web
The Web does not have a central listing of resources. It is always changing because
of its dynamic nature and as:
• new sites are added
• new pages are added to sites
• sites and pages are deleted
• content on existing pages is changed.

There are no reliable statistics about the amount of information on the Web.
However, one estimate is that a new page is added every four seconds.

To access useful information requires a number of strategies including:
• using URLs based on recommendations, such as in a newspaper article or from

a librarian
• using URLs from sites you know are quality sites that provide quality links
• creating bookmarks of useful sites from previous searches.

Search engine or search directory
The two basic choices for searching the Web are: 
• a search engine, or
• a search directory (sometimes called a guide).

What is a search engine?
A search engine is a database that contains an index of pages stored on the Web.
The database stores key words from web sites. The search engine includes the
ability to search the database very quickly for words you specify.

Specialist software called ‘spiders’ and ‘web-crawlers’ retrieve information from
sites. These extracts are compiled in databases that are accessed when the search
engine is engaged.

Any search of the Web reflects the database at its last update. Hence, a search
might produce results that are out of date.

Searching with Google
Google is the most popular search engine.

To search for a key word using Google, go to the Google site at:
www.google.com.au

Now enter the keyword to be searched in the dialogue box and press enter.
Searching for the keyword ‘tennis’ returned over 50 000 000 documents meeting
this criterion.

Refining a search
A single keyword often returns far too many documents or sites to be useful. The
search may be refined by:
• adding extra words
• using Boolean logic with operators such as ‘and’ and ‘or’
• searching for a phrase.
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If the search is made for ‘Australian Open Tennis’, documents that contain one
or more of these words will be identified. The results will be listed in order of the
most useful. Using Google, this returned about 2 000 000 documents.

The official Australia Open web site shows as the first of these sites.

What is a search directory?
A search directory, or search guide,  is a high quality index of websites, which are
organised into categories.  The category types and sites within the index are
developed by researchers.  Yahoo! has a comprehensive directory.  

A directory is very useful when a user is not exactly sure of what they're looking
for. Instead of typing a search query, the user can browse by drilling down
through the category structure via links.  Selecting the category, for example,
Sport, leads to a page with sub-categories and users keep moving through
directory sub-categories until the required information is found.

Figure 5.14 shows the Yahoo! Australia and New Zealand site at:
au.yahoo.com

Your turn
1 Use AltaVista to search for ‘tennis’. (www.altavista.com)
2 Use a search engine to find sites that refer to the following key words:

a Australian women’s cricket
b Beijing Olympics
c El Nino

Figure 5.13
Google is the most 
popular search
engine
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Developing a search strategy
Searching for information can be difficult. To be successful you should aim to:

• minimise the number of possible irrelevant links a search may give
• maximise the relevance of those links given.

Searches are based on key words entered that are matched to data in the search
engine database. This requires you to:

• identify the search topic
• identify the key areas
• select key words based on the search topic
• select an appropriate search engine
• work out the search logic.

Searches can be restricted to sites within a single country.

Your turn
1 Access the White Pages printed directory and find the following:

a your telephone number
b your school’s telephone number
c a friend’s telephone number.
Access the White Pages on line at http://www.whitepages.com.au and look up the
telephone numbers.

2 What are the advantages and disadvantages of using the White Pages directory on the
web compared with other methods of finding the number?

Figure 5.14
Yahoo! home page
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Information quality
It is unwise to accept information on the Web at face value. Data and information
on the Web needs to be looked at carefully to determine its quality and use.

Some factors that may assist are:

• the status and reputation of the organisation or individual hosting the site
• references to the site from other sites
• references to the site from printed material
• your own previous experience with the site.

Copyright and the World Wide Web
Information from the Web is subject to copyright law. The Berne Convention and
the Universal Copyright Convention protect countries that are signatories to those
agreements.

People who copy and use material from the Internet are subject to the laws
within their own countries. Material downloaded from the Internet cannot be
published unless one of the following conditions is met:

• permission to use it is given by the owner
• use of the material is granted under licence
• the material is purchased
• the material is identified as being shareware or royalty free.

Citing electronic references in a bibliography
When completing a work in which other materials are referred to, the source of
these references should be listed. This allows verification of information and
follow-up by others interested in the source material.

The Harvard (Author Date) System is an example of a system used for
bibliographies. For references to a web page and other on-line material the
following elements would need to be identified:

Table 5.2 Elements to include in references from the World Wide Web

Element Example Format

author Mitchell, Selina person or corporate author

year of publication (2000) in round brackets

title HREOC call for easy websites

type of medium [on-line] in square brackets

place of publication Australia

publisher News Limited

address http://www.theaustralian include word ‘Available’ and 
.com.au/techno/index.htm double colon

access date (date [12 October 2004] include word ‘Accessed’ and square brackets
viewed, or the 
date of download)

format date in day, month and year with the month as text

WORKSHEETWORKSHEET
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The example from Table 5.2 would be written as follows:

• Mitchell, Selina (2000) HREOC call for easy websites [on-line] Australia News
Limited. 
Available: http://www.theaustralian.com.au/techno/index.htm 
Accessed: [12 September 2004]

Your turn
Select two pages from the Web and show how the pages would be used as an item in a
bibliography.

Censorship and the Web
No single government or organisation has control over the Web. No one can
control the type and quality of the information that is available. There is the
possibility that material on the Web could be:

• contrary to the political views of a particular government
• pornographic
• used to promote views that are racist or irreligious
• used to promote or incite violence.

Many organisations use software and hardware to restrict access
to unacceptable and undesirable sites and content. However, it is impossible to
ensure all undesirable links and material can be filtered out.

The Internet in schools
Many schools have an ‘acceptable use policy’ for the Internet. This is a policy and
code of conduct setting down guidelines for responsible use of the Internet. They
usually:

• list the responsibilities of students using the Internet
• list the rights of students using the Internet
• outline the consequences of breaching the guidelines.

Your turn
Does your school have an acceptable use policy? If so, what are the main features of the
policy? Do you think the policy is suitable and effective?

Useful sites
Search engines
Yahoo! au.yahoo.com
HotBot www.hotbot.com
Google www.google.com
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Your turn
1 Use the Web to find out about the following scientists:

a Ernest Rutherford
b Marie Curie
c Wilhelm Roentgen
d William Harvey
e Howard Florey.
For each of them, find out their nationality and when they lived, and comment on their
significant contribution to science. Carefully cite each web address that you use.

2 Use the web to find out about the following people:
a Emily Pankhurst
b Dame Nellie Melba
c Florence Nightingale
d Mary Robinson
e Elle Macpherson.
For each of them, find out their nationality when they were born and when they died (if
they have), and make a comment on their significant contribution to the community.
Carefully cite each web address that you use.

Using the Internet in a safe manner
The Internet enables easy access and sharing of information. People should make
sure that they are providing information in safe and secure communication and
that they do not endanger personal safety.

For example:
• do not give out or reveal to others information such as passwords, home

addresses, telephone numbers and log-in information
• do not indulge others by replying to e-mails and other communications that

are offensive
• do not make personal contact with someone met via the Internet unless their

details and identity can be verified beforehand
• do not open e-mails and attachments unless you know the sender.
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